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หลงัจากที ่Photoshop CS6 เปิดตวัให้ใช้งานประมาณ 1 ปีเศษ  

Adobe ก็ผุดซอฟต์แวร์ชุดใหม่โดยใช้ช่ือ Creative Cloud หรือ 

CC ซึ่งสร้างความตื่นตัวให้ผู้ ใช้งานทั่วโลกได้ไม่น้อย ไม่เพียงแต่

ฟีเจอร์ใหม่ทีถ่กูเพิม่เข้าไปในแต่ละโปรแกรม แต่รปูแบบการจ่ายเงนิ

ซื้อซอฟต์แวร์แบบเบ็ดเสร็จถูกเปลี่ยนเป็นการเช่ารายเดือน เรียกได้

ว่า Adobe เทหมดหน้าตักกับการเปลี่ยนแปลงครั้งนี้
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อะไรคือ Adobe Creative Cloud ?

Package และ Plan การช�าระเงินของ Adobe Creative Cloud แบบต่างๆ ที่ผู้ใช้สามารถเลือกก่อน 

เริ่มต้นดาวน์โหลดโปรแกรมมาติดตั้ง

ในอดีตเราคุ้นเคยกับ Adobe Creative Suite ที่เป็นโปรแกรม

แบบแบ่งชดุ โดยแบ่งเป็นชดุส�าหรบันกัออกแบบกราฟิก, เวบ็ดไีซน์ หรอื

งานตัดต่อวิดีโอ แต่ส�าหรับ Adobe Creative Cloud เราสามารถเลือก

ใช้ โปรแกรมที่ต้องการได้เอง (หรือเลือกเป็นชุดตาม Package) โดย

เลือกดาวน์โหลดจากเว็บไซต์ www.adobe.com

ดงัทีก่ล่าวไว้ในตอนต้นว่า Adobe CC ได้ปรบัเปลีย่นรปูแบบการ

ช�าระเงินเป็นแบบรายเดือน ซึ่งผู้ ใช้สามารถเลือก Plan ที่เหมาะสมได้ 

โดยแบ่งออกเป็น 3 ชุด ได้แก่ Individauls ที่เหมาะกับผู้ ใช้งานทั่วไป, Teams and Business ที่เหมาะกับการท�างานใน

กลุ่มใหญ่ และ Education  ที่เหมาะกับการศึกษา (เป็น Package ชั่วคราว)

อย่างไรก็ตาม Package และ Plan เหล่านี้อาจมีการเปลี่ยนแปลงไปตาม Promotion ที่ Adobe จะจัดขึ้นส�าหรับ

ผู้ ใช้งานในแต่ละช่วงเวลา

Adobe Creative Cloud ดีอย่างไร ?

จากรายละเอยีดทีก่ล่าวมาข้างต้นจะเห็นว่า Adobe Creative Cloud ค่อนข้างยุง่ยากกว่า Adobe เวอร์ชนัทีผ่่านมา  

แต่มีข้อดีที่น่าสนใจดังนี้

• Upgrade โปรแกรมฟรีตลอดอายุการใช้งาน ซึ่งเราไม่จ�าเป็นต้องลบ หรือติดตั้งโปรแกรมใหม่อีกต่อไป

• เมื่อมี Features ใหม่ หรือการแก้ไขโปรแกรม (Patch) ก็สามารถอัพเดตได้ตลอดเวลา

• พืน้ท่ีฟรสี�าหรบัเก็บไฟล์งานบน Creative Cloud แบบออนไลน์ สงูสดุถงึ 100 GB ซึง่ช่วยให้เราสามารถใช้งาน 

ที่ส�าคัญ และแชร์ไฟล์งานเพื่อท�างานร่วมกับเพื่อนร่วมงานได้ทุกหนทุกแห่ง

• Admin Console เป็นส่วนที่ใช้จดัการสทิธผิู้ ใช้งานไฟล์ทีแ่ชร์บน Creative Cloud ซึง่เราสามารถก�าหนดสทิธใิห้ 

ผู้ ใช้แต่ละคนท�าอะไรกับไฟล์ได้บ้าง เช่น เปิดดูได้อย่างเดียว, แก้ไขได้ เปลี่ยนแปลงและบันทึกงานได้ เป็นต้น

ในแต่ละ Plan ยังแบ่ง

ออกเป็น Package ย่อยๆ ซึ่งมี

ราคาที่แตกต่างกัน เช่น Single 

App ส�าหรับผู้ที่ต้องการใช้งาน 

โปรแกรมเดยีวเท่านัน้ กส็ามารถ 

เลือกติดตั้งได้ ในราคาเริ่มต้นที่  

600 บาทต่อเดือน หรือเลือก 

Package แบบ Complete หาก 

ตอ้งตดิตั้งแบบบฟุเฟ่ต ์ (1,500 

บาทต่อเดอืนส�าหรบัผู้ ใช้รายใหม่ 

หรือ 900 บาทต่อเดือนส�าหรับ 

ผู้ ใช้เก่าทีต่ดิตัง้โปรแกรมเวอร์ชนั  

CS3 หรอืสงูกว่าไว้แล้ว)
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ตัวอย่างที่แสดงให้เห็นว่า ภาพก่อนปรับแต่งที่ขาดความ 

คมชัดเนื่องจากความสั่นไหวขณะถ่ายภาพ แต่เมื่อแก้ไขด้วย 

ค�าสั่ง Camera Shake Reduction แล้ว ภาพมีความคมชัดขึ้น

เป็นอย่างมาก

• ทมีงาน Expert Support จาก Adobe และ Support จาก I.T.Solution Computer (Thailand) Co., Ltd. ทีจ่ะอยู่ 

เคียงข้างในการให้ค�าปรึกษาทั้งส่วนของการใช้งานโปรแกรม หรือในส่วนของการติดตั้งโปรแกรม เป็นต้น

• สามารถเลือกดาวน์โหลดโปรแกรมทั้งหมดบน Adobe Creative Cloud ได้โดยไม่จ�ากัดเหมือนที่เคยเป็นใน

เวอร์ชันที่ผ่านๆ มา (เมื่อเลือก Package แบบ Creative Cloud complete plan เท่านั้น)

มีอะไรใหม่ใน Photoshop CC บ้าง ?
สิ่งแรกที่ผู้ ใช้งานส่วนใหญ่ค�านึงถึงเมื่อ Adobe เปิดตัวโปรแกรมเวอร์ชันใหม่ทุกครั้งก็คือ มีฟีเจอร์อะไรใหม่บ้าง 

ส�าหรับ Photoshop CC ได้เพิ่มฟีเจอร์ใหม่เข้าไป (ถึงแม้จะไม่มากนักในตอนแรก แต่จะมีการอัพเดตฟีเจอร์ใหม่เรื่อยๆ 

ในภายหลัง) โดยมีฟีเจอร์เด่นๆ ดังนี้

Camera Shake Reduction 

ค�าส่ัง Camera Shake Reduction เป็นฟิลเตอร์ 

ใหม่ในกลุม่ Sharpen ที่ไม่เพยีงแต่สามารถเพิม่ความ

คมชัดให้ภาพได้ แต่ยังช่วยลดความสั่นไหวของภาพ 

ที่เกิดขึ้นขณะถ่ายภาพได้เป็นอย่างดี

ตัวอย่าง Interface ค�าสั่ง Smart Sharpen ของ Photoshop  

CS6 (ภาพซ้าย) และ Photshop CC (ภาพขวา) ที่จะเห็นว่าเวอร์ชัน

ใหม่สามารถปรับแต่งภาพได้สะดวกกว่า และให้คุณภาพที่ดีกว่าด้วย

ปรับปรุง Smart Sharpen ใหม่

ค�าสั่ง Smart Sharpen ไม่ใช่ค�าสั่งใหม่ แต่ใน Photoshop CC ได้เพิ่มขีดความสามารถที่สูงขึ้น โดยสามารถปรับ

แต่งภาพให้คมชัดขึ้นโดยไม่ลดทอนคุณภาพของภาพ อีกทั้ง Interface ของค�าสั่งที่เรียบง่าย ไม่ซับซ้อนเหมือนเวอร์ชัน 

ที่ผ่านๆ มา
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ตัวอย่างการตกแต่งภาพใน 

Photoshop CC โดยใช้ค�าสั่ง 

Camera Raw Filter ซึ่งจะเห็น

ว่าสามารถปรับแต่งภาพได้เช่น

เดียวกับการตกแต่งภาพ RAW

ตัวอย่างการใช้ค�าสั่ง Ganerate image assets from layers 

แปลงข้อความธรรมดาให้กลายเป็นไฟล์ภาพอย่างง่ายดาย

ตัวอย่างการปรับเปลี่ยนภาพม้านั่งที่บิดเบี้ยว ให้มี 

มุมมองที่ถูกต้องด้วยค�าสั่ง Perspective Warp

Camera Raw 8

ในเวอร์ชันนี้มีการปรับปรุงค�าสั่ง Camera Raw 8 ให้ท�างานกับกล้องรุ่นต่างๆ ได้ยืดหยุ่นมากข้ึน ที่ส�าคัญ 

Photoshop CC ยงัเพิม่ค�าสัง่ Camera Raw เป็นฟิลเตอร์ส�าหรบัแก้ไขภาพในแต่ละเลเยอร์ได้ด้วย จงึท�าให้การปรบัแต่ง 

ภาพมีความยืดหยุ่นยิ่งขึ้น

Generate image assets from layers

เป็นค�าสั่งใหม่ที่น ่าสนใจ และใช้งานได้ดีเมื่อ 

ท�างานร่วมกับการออกแบบเว็บไซต์ โดยเราสามารถสร้าง

ไฟล์ใหมด่ว้ยการเปลีย่นชือ่เลเยอร์ พร้อมกบัก�าหนดขนาด 

ภาพและนามสกุลไฟล์ เพียงเท่าน้ีเราก็จะได้ภาพใหม่  

โดยไม่จ�าเป็นต้องบันทึกแบบแยกเลเยอร์เหมือนเวอร์ชัน

ที่ผ่านมา

Perspective Warp

Perspective Warp เป็นฟีเจอร์ใหม่ทีถ่กูเพิม่เข้ามา  

โดยค�าสั่งนี้จะช่วยให้เราสามารถปรับเปลี่ยนมุมมองของ

ภาพถ่ายที่บิดเบ้ียวเน่ืองจากเลนส์มุมกว้างที่ใช้ หรือข้อ

บกพร่องอื่นๆ ให้กลายเป็นภาพที่มีมุมมองที่ถูกต้องและ

สมบูรณ์ได้อย่างง่ายดาย
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ตัวอย่างการวางออบเจ็กต์ด้วยค�าสั่ง Linked Smart Object  

ลงไปบนไฟล์ภาพ ซึ่งเราสามารถปรับแต่ง Object นี้ ใหม่ได้

โดยคลิกปุ่ม Edit Contents หลังจากน้ันภาพต้นฉบับก็จะปรับ

เปลี่ยนไปด้วย

Linked Smart Object

เป็นฟีเจอร์ใหม่ที่สนับสนุนการท�างานร่วมกัน 

หลายๆ ไฟล์ โดยที่เราสามารถวางภาพด้วยค�าสั่ง 

Linked Smart Object ลงไปในงานทีอ่อกแบบ และเมือ่ 

มีการปรับแต่งแก้ไขชิ้นงาน ก็จะท�าให้ภาพต้นฉบับมี

การปรับปรุงตามไปด้วย ซ่ึงช่วยลดความซ�้าซ้อนใน 

การท�างานได้เป็นอย่างดี

3D Printing

นอกจากความสามารถในการ

ออกแบบงาน 3D ได้แล้ว Photoshop 

CC ยังสามารถพิมพ์งาน 3D ออกมา

เป็น Model ได้ทันที แต่หากผู้ ใช้งานไม่มี

เครื่องพิมพ์ 3D ก็สามารถส่งไฟล์งานผ่าน

ค�าส่ังไปยงั www.shapeways.com ซึง่จะ 

ท�าหน้าที่พิมพ์ Model 3D ออกมาแล้ว 

จัดส่งให้ ในภายหลังได้ด้วย

นอกจากฟีเจอร์หลักดังกล่าวแล้ว Photoshop CC ยังมีการเพ่ิมเติมคุณสมบัติพิเศษอ่ืนๆ รวมถึงพัฒนาค�าสั่ง

เก่าๆ ให้มีประสิทธิภาพสูงขึ้นดังนี้

• รวมฟีเจอร์ของ Photoshop Extended เข้ามาในรุ่นหลัก

• อัพโหลดผลงานขึ้นไป Behance ซึ่งเป็นเว็บไซต์สร้าง Portfolio ได้โดยตรง

• ปรับปรุง Interface ของแต่ละโปรแกรมในชุด Creative Cloud ให้สอดคล้องกันและท�างานง่ายขึ้น

• แสดงภาพแบบ HiDPI ส�าหรับการแสดงผลบนจอ Retina

• ปรับปรุงศักยภาพการท�างานบนจอขนาดใหญ่

• เพิ่มความเสถียรในการบันทึกงานผ่านระบบเน็ตเวิร์ค

• เพิ่มศักยภาพให้ค�าสั่งต่างๆ สามารถควบคุมแสงเงาและโทนกลางได้ดีขึ้น

• เพิ่มศักยภาพให้ค�าสั่ง Content-Aware

• เพิ่มศักยภาพการท�างานกับเส้น Path และ Anchor Point ที่สามารถเลือกท�างานได้ง่ายขึ้น

• เพิ่มขีดความสามารถให้ ใช้งานฟิลเตอร์ 24 ตัวกับภาพ 32-bit ได้

• ออปชันใหม่ส�าหรับการเลือกท�างานกับเลเยอร์

• คัดกรองเลเยอร์ที่ต้องการเลือกท�างานด้วย Isolation mode changes บนพาเนล Layers
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ถึงแม้ Photoshop จะมีความสามารถหลักในการรีทัชภาพ 

และสร้างเอฟเฟ็กต์ให้ภาพถ่าย แต่ก็ยังมีเครื่องมืออีกกลุ่มหนึ่งที่

สนับสนุนการท�างานด้านการวาดภาพ ซึ่งเราสามารถสร้างรูปทรง

แบบเวคเตอร์อย่างง่ายๆ ไปจนถึงการสร้างเส้นพาธเพ่ือออกแบบ

งานกราฟิกที่สวยงามได้มากมาย

15
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รู้จักกับเครื่องมือวาดรูปทรงและสร้างเส้นแบบ Vector
นอกจากการตัดต่อ ปรับแต่งสีสันภาพให้สวยงามได้แล้ว เรายังสามารถใช้ Photoshop ในการวาดรูปทรง หรือ

ภาพแบบลายเส้นที่มีความซับซ้อนได้ด้วยเครื่องมือในกลุ่ม Shape Tool และ Pen Tool โดยเครื่องมือเหล่านี้ครอบคลุม

ทั้งเรื่องของการสร้าง Selection ให้ภาพได้อย่างแม่นย�า การสร้างเส้น Path เพื่อใช้ ในการสร้างลายเส้น หรือใช้ก�าหนด

พื้นที่ในการลงสีได้ด้วย

• Shape คือ การก�าหนดให้เส้นพาธหรือรูปทรง 

ทีส่ร้างขึน้เป็นเลเยอร์ใหม่ สามารถเปลีย่นสพ้ืีน ใส่เส้นขอบ 

และปรับแต่งรูปทรงใหม่ได้โดยไม่สูญเสียความคมชัด

ตัวอย่างการน�าเครื่องมือ  (Pen Tool) ตัดภาพออกจากพื้นหลัง สร้างลายเส้น และลงสีได้อย่างน่าสนใจ

ก�าหนดรูปแบบของเส้นพาธให้

เครื่องมือก่อนใช้งาน

ตัวอย่างรูปทรงที่ ได้จากเครื่องมือ  (Custom Shape Tool) 

โดยก�าหนดคุณสมบัติแบบ Shape ที่สามารถใส่สีสันและเส้นขอบ

ได้อย่างง่ายดาย

ตัวอย่างของการก�าหนดคุณสมบัติแบบ Path จะเห็นว่ามีเพียง

เส้นพาธเท่านั้น ที่สามารถปรับแต่งในภายหลังได้สะดวกขึ้น

• Path คือ การก�าหนดให้การวาดรูปทรงมี

เพียงเส้นพาธเท่านั้น สามารถปรับแต่งเส้นพาธ รวมถึง 

การแปลงเส้นพาธเป็น Selection หรือลายเส้นใน 

ภายหลังได้ด้วย

การกำ หนดรูปแบบเส้นพาธ
ก่อนที่จะเริ่มต้นใช้งานเครื่องมือต่างๆ สร้างเส้นพาธหรือรูปทรง จะต้อง 

มีการก�าหนดคุณสมบัติของเส้นพาธเสียก่อนว่า ต้องการให้รูปทรงที่สร้างข้ึนนั้นมี

คุณสมบัติเช่นใด โดยสามารถก�าหนดได้ 3 แบบดังนี้
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• Pixels ใช้ส�าหรับการสร้างรูปทรงให้มีเพียง 

สีพื้นอย่างเดียว โดยการปรับแต่งในภายหลังท�าได ้

ค่อนข้างยาก และอาจกระทบถึงความคมชัดของภาพ

ตัวอย่างการก�าหนดรูปทรงโดยเลือกออปชัน 

Pixels จะเห็นว่ามีเพียงสีพื้นเท่านั้น

วาดรูปทรงด้วยกลุ่มเครื่องมือ Shape Tool
การวาดรูปทรงด้วยเครื่องมือกลุ่ม Shape Tool สามารถก�าหนดคุณลักษณะของแต่ละเครื่องมือเพิ่มเติมได้ โดย

มีความแตกต่างกันดังนี้

วาดรูปสี่เหลี่ยมและสี่เหลี่ยมขอบมน

เราสามารถวาดรูปสี่เหลี่ยมได้ด้วยเครื่องมือ  (Rectangle Tool) และรูปสี่เหลี่ยมขอบมนด้วยเครื่องมือ  

 (Rounded Rectangle Tool) โดยทั้ง 2 เครื่องมือนี้สามารถปรับแต่งค่าได้เหมือนกันดังนี้

เลือกรูปแบบของเส้นพาธ

คลิกเพื่อเลือกการควบคุม

แบบอื่นๆ ของเครื่องมือ

ออปชนัการก�าหนดสดัส่วน

ส�าหรับวาดรูปทรง

ก�าหนดความมนของรูปทรง ในกรณีที่ใช้เครื่องมือ

 (Rounded Rectangle Tool)

เลือกออปชันก�าหนดสัดส่วนรูปสี่เหลี่ยม

ส�าหรับการก�าหนดออปชันการวาดรูปสี่เหลี่ยม และสี่เหลี่ยมขอบมนให้ตรงกับความต้องการมากขึ้นมีดังต่อไปนี้

•	 Unconstrained คือ การวาดรูปทรงโดยไม่ก�าหนดสัดส่วน 

•	 Square ก�าหนดให้วาดรูปทรงเป็นสี่เหลี่ยมจัตุรัส 

•	 Fixed Size ก�าหนดขนาดของรูปทรงตายตัว สามารถใส่ค่าความกว้างในช่อง W: และความสูงในช่อง H:  

โดยสามารถก�าหนดหน่วยเป็น px, cm หรือ in ได้ตามต้องการ

•	 Proportional ใช้ก�าหนดสัดส่วนของรูปทรง

•	 From Center ใช้ส�าหรับก�าหนดการวาดรูปทรงจากตรงกลาง

วาดรูปวงกลมและวงรี

การวาดรปูวงกลมด้วยเครือ่งมือ  (Ellipse Tool)  

ท�าได้ง่ายๆ โดยแดรกเมาส์สร้างรูปทรงให้มีขนาดและ

ต�าแหน่งตามต้องการ โดยการก�าหนดออปชันเพิ่มเติมนั้น

สามารถท�าได้เช่นเดยีวกบัเครือ่งมอื  (Rectangle Tool)  

และ  (Rounded Rectangle Tool)
ตัวอย่างการวาดรูปวงกลมและวงรีด้วยเครื่องมือ  (Ellipse Tool)
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ออปชันการวาดรูปหลายเหลี่ยม

เราสามารถก�าหนดออปชันให้เครื่องมือ  (Polygon Tool) ในการวาดรูปทรงแบบอื่นๆ ได้อีกดังนี้

•	 Radius คือ การก�าหนดรัศมีของรูปทรงที่วาดขึ้น สามารถก�าหนดหน่วยของรัศมีเป็น px, cm หรือ in ก็ได้

•	 Smooth Corners เป็นตัวเลือกส�าหรับปรับมุมของรูปทรงที่วาดให้โค้งมนมากขึ้น

•	 Star เป็นตัวเลือกส�าหรับเปลี่ยนมุมของรูปทรงที่สร้างขึ้น ให้มุมแหลมออกมาเหมือนกับดาว

•	 Indent Sides By ก�าหนดเปอร์เซ็นต์ให้ความยาวของรัศมีดาว

•	 Smooth Indents ก�าหนดให้มุมของรัศมีมีความนุ่มนวล

วาดรูปหลายเหลี่ยม

การวาดรูปหลายเหลี่ยมด้วยเครื่องมือ  (Polygon 

Tool) มักใช้สร้างรูปทรง เช่น รูปสามเหลี่ยม ห้าเหลี่ยม หรือ

ปรับออปชันเพิ่มเติมให้สามารถวาดรูปทรงเป็นดวงดาว หรือ 

รูปดอกไม้ โดยการก�าหนดค่าต่างๆ มีดังนี้

รูปที่วาดโดยก�าหนดค่า 

Sides = 8 และเลือกออปชัน 

Smooth Corners และ Star

รูปที่วาดโดยก�าหนดค่า 

Sides = 8 และเลือกออปชัน 

Smooth Corners, Star และ

ก�าหนด Smooth Indents

รูปที่วาดโดยก�าหนดค่า 

Sides = 8 และเลือกออปชัน 

Star

รูปที่วาดด้วยเครื่องมือปกติ

โดยก�าหนดค่า Sides = 5

ออปชันการวาดรูป

หลายเหลี่ยม

ก�าหนดจ�านวนมุมของรูปทรง

ก�าหนดความหนาของเส้น

ออปชันการสร้างเส้นตรง

วาดเส้นตรง

เครื่องมือ  (Line Tool) มีความสามารถในการสร้างเส้นตรง

โดยก�าหนดความหนาได้ตามต้องการ และสามารถเลือกสร้างหัวลูกศรได้

ทั้งหัวเส้นและปลายเส้น โดยการปรับแต่งทั้งหมดท�าได้ดังนี้

การสร้างรปูทรงด้วยเครือ่งมอื 

กลุ่ม Shape Tool สามารถ 

กดปุ่มต่างๆ บนคีย์บอร์ด

เพื่อรวมพื้นที่ของรูปทรง หรือตัดพื้นที่

ของรูปทรงออกจากกันได้ เช่น กดปุ่ม 

 ขณะวาดรูปก็จะสามารถรวม

พื้นที่, กดปุ่ม  ขณะวาดรูปทรงก็จะ 

เป็นการตัดพื้นที่ส่วนที่ทับออกจากกัน  

หรือกดป ุ่ม +  ขณะวาด 

รูปทรงก็จะสามารถเก็บพื้นที่ส่วนที่ทับ

กันไว้ แล้วตัดพื้นที่รอบนอกออก โดย 

วิ ธีการใช ้งานยังสามารถเลือกจาก

ออปชันบาร์ได้ด้วย โดยศึกษาเพิ่มเติม

ได้จากหัวข้อเรื่องการวาดรูปทรงแบบ

รวม-ลดพื้นที่หน้า 362
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นอกจากการท�างานกับภาพถ่ายได้แล้ว Photoshop ยังเพิ่ม

ขีดความสามารถในการท�างานกับไฟล์ 3D ได้ด้วย โดยเราสามารถ

ปั้นรูปทรง ใส่แสงเงา รวมถึงการแปลงรูปภาพหรือตัวอักษรที่สร้าง

ขึ้นให้กลายเป็นรูปทรง 3D ได้อย่างง่ายดายและสวยงามไม่แพ้

โปรแกรม 3D อื่นๆ21
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พื้นฐำนกำรทำ งำนกับ 3D (Photoshop Extended)
เราสามารถใช้ Photoshop ท�างานกับไฟล์ 3D ได้ ทั้งจากการ Render ขึ้นเอง หรือการน�าไฟล์จากโปรแกรม  

Adobe Acrobat 3D เวอร์ชนั 8, 3D Studio Max, Alias, Maya และ Google Earth ได้ด้วย แต่คอมพวิเตอร์ที่ใช้งานจะต้อง 

มีศักยภาพที่เพียงพอ รวมถึงการ์ดแสดงผลจะต้องรองรับการท�างานด้วย 

คลิกเครื่องหมายถูกหน้า Use Graphics Processor 

เพื่อให้สามารถท�างานกับไฟล์ 3D รวมทั้ง Convert 

ภาพธรรมดาให้เป็น 3D ได้

ส�าหรบัผู้ ใช้งาน Photoshop ทีม่กีาร์ดจอรองรบั

การท�างาน จะต้องเปิดออปชนัเพือ่ให้สามารถใช้งานค�า

สัง่ในกลุม่ 3D ได ้โดยคลกิเมนู Edit > Preferences >  

Performance หลงัจากนัน้คลกิเครือ่งหมายถกูหน้า Use  

Graphics Processor ดังภาพ

สร้ำงภำพ 3D ด้วยคำ สั่งพื้นฐำน
 ส�าหรับผู้ ใช้งาน Photoshop ที่ยังไม่มีความช�านาญในการขึ้นโมเดลวัตถุ 3D 

ใช้งานเอง แต่ก็สามารถใช้ค�าสัง่ต่างๆ  แปลงภาพทีเ่ปิดใช้งานเป็นวตัถ ุ3D ได้จากพาเนล 

3D หรือคลิกเมนู 3D > New Mesh from Layer ตัวอย่างต่อไปนี้จะเป็นการสร้างวัตถุ 

3D จากค�าสั่ง Mesh From Preset ที่มีรูปแบบส�าเร็จรูปอยู่ 13 แบบดังนี้

เลือกท�างานกับพาเนล 3D แล้วเลือกออปชันการสร้างรูปทรง

ที่ต้องการ แล้วคลิกปุ่ม Create เพื่อสร้างวัตถุ 3D

Cone เป็นรูปทรงแบบกรวย Cube เป็นรูปทรงสี่เหลี่ยมที่มีภาพ

เหมือนกันทุกด้าน

Cube Wrap เป็นรูปทรงสี่เหลี่ยมที่

สามารถแยกแต่ละด้านออกจากกันได้
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 Donut เป็นรูปทรง 3D แบบโดนัต  Hat เป็นรูปทรง 3D แบบหมวก

 Ring เป็นรูปทรง 3D แบบวงแหวน

Cylinder คือ รูปทรงกระบอก

 Sphere เป็นรูปทรง 3D แบบทรงกลม

Pyramid เป็นรูปทรง 3D แบบที่สามารถ

เพิ่มภาพใหม่ให้ทุกด้านได้

 Soda Can เป็นรูปทรง 3D

   แบบกระป๋องน�า้อัดลม

 Spherical Panorama เป็นรูปแบบการ

  แสดงภาพพาโนรามาแบบทรงกลม 360
o

ตัวอย่างการสร้างรูปทรง 3D ด้วยค�าสั่ง Postcard

 Wine Bottle เป็นรูปทรง 3D 

  แบบขวดไวน์

นอกจากการสร้างรูปทรงด้วยออปชัน Mesh From 

Preset แล้ว เรายังสามารถสร้างรูปทรงให้มีลักษณะเหมือน

โปสต์การ์ด โดยเลอืกออปชนั Postcard หรอืคลกิเมน ู3D > New  

Mesh from Layer > Postcard จะได้ผลลัพธ์ดังภาพ 
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เลือกใช้เครื่องมือส�าหรับจัดการรูปทรง 3D ได้จากออปชันบาร์

เครื่องมือสำ หรับจัดกำรไฟล์ 3D
เครื่องมือที่ใช้จัดการกับไฟล์ 3D จะมีอยู่ 5 ตัวด้วยกัน สามารถหมุนรูปทรง หรือปรับระยะใกล้-ไกลของรูปทรงได ้

เราสามารถใช้เครื่องมือเหล่านั้นได้จากออปชันบาร์ โดยแต่ละเครื่องมือมีหน้าที่ดังนี้

อีกหนึ่งค�าสั่งที่ใช้สร้างภาพ 3D คือ ออปชัน Mesh From Depth Map หรือคลิกเมนู 3D > New Mesh from 

Layer > Depth Map to ค�าสั่งนี้จะน�าระดับความสว่างในภาพมาค�านวณความสูง-ต�่าให้รูปทรง โดยมีทั้งหมด 4 แบบดังนี้

ภาพพื้นผิวที่มีระดับความสว่างที่แตกต่างกัน

ภาพพื้นผิวที่มีระดับความสว่างที่แตกต่างกัน

รูปทรง 3D แบบ Plane ที่วัตถุจะสูง-ต�่า

ตามระดับความสว่างของภาพ 

รูปทรง 3D แบบ Cylinder ที่วัตถุจะหมุนวน

เป็นทรงกระบอก แต่จะมีระดับสูง-ต�่าตาม

ความสว่างภาพ

รูปทรง 3D แบบ Sphere ที่วัตถุจะหมุน

วนเป็นทรงกลม-รี แต่จะมีระดับสูง-ต�า่ตาม

ความสว่างภาพ

รูปทรง 3D แบบ 2 Sided-Plane ที่วัตถุ

จะสูง-ต�า่ตามระดับความสว่างของภาพ

ทั้ง 2 ด้าน 
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